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Introduction

Installation

Before beginning the exercises, install the software and register it as either demo or subscription. Demo
maode serves as a no-cost viewer, allowing vou to export, print, or plot projects that have not been edited.

Imperial and Metric Convention

The exercises in this guide contain both imperial and metric values. This means that when you see an
imperial value, a metric value is displayved in square brackets next to it.

For example: In the Type Selector, select Basic Wall : Generic - 6" [200mm].

All audiences using the metric measurements should follow the metric values in brackets only; all metric
measurements are in millimeters. Note that the imperial and metric values are not direct conversions, but
appropriate values for completing either the imperial or metric project.

Exploring the User Interface

When the Revit Architecture window is displayed, take a minute to view the different sections.
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Menu Bar and Toolbars

At the top of the window is the standard Microsoft® Windows®-based menu bar, from which you can access
all Revit Architecture commands. Icons on the toolbars are buttons for executing common Revit Architecture

commands.

Options Bar

Below the toolbars is the Options Bar, which displays command options for the current operation. If you
click Wall on the Design Bar on the left side of the Revit Architecture window, the Options Bar displays

options related to the Wall command.
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Type Selector

On the left side of the Options Bar is the Type Selector, a drop-down menu that lists different types of
elements to add to a project. You can choose an element type by selecting it from the drop-down menu of
the Type Selector.

Properties Button

To the right of the Type Selector is the Properties button E , which accesses a dialog in which you can
change various parameters of a selected component.

Design Bar

On the left side of the Revit Architecture window is the Design Bar, which lists the commands available for
the currently selected tab. There are 10 tabs: Basics, View, Modelling, Drafting, Rendering, Site, Massing,
Room and Area, Structural, and Construction. To see all the tabs, right-click on the Design Bar. To display
a single tab, click the tab name.

Project Browser

To the right of the Design Bar is the Project Browser. The Project Browser is a listing of all views, families,
and groups in the project. You can select any of the items listed in the Project Browser. A convenient way
to open a view is to double-click the view name in the Project Browser list.

Status Bar

At the lower left corner of the drawing area is the Status Bar, which displays the status of the current command
or the name of a highlighted element.

View Control Bar

At the lower left corner of the drawing area, above the Status Bar, is the View Control Bar. The controls are
graphical shortcuts to various View commands, namely scale, detail level, graphics style, advanced model
graphics, shadows, crop region, and temporary hide/isolate. Some views, such as sheets, drafting, and rendered
views, have limited controls.

Drawing Area

The drawing area of the Revit Architecture window displays views (and sheets and schedules) of the current
project. By default, each time you open a view in a project, the view displays in the drawing area on top of
other open views. You can use commands on the Window menu to arrange the project views.



Creating a Project

In this first exercise, you create and name a project in which you will create the building model shown.

i

1

1 Create a project:
B In the drawing area, under Projects, click New.

B In the New Project dialog, under Create New, verify that Project is selected.
B Under Template file, verify the second option is selected, and click Browse.
|

In the left pane of the Choose Template dialog, click Training Files, and open
‘mperial\Templates [Metric\Templates].

B Select default.rte [DefaultMetric.rte], and click Open.
B In the New Project dialog, click OK.

2 Name and save the project file:
m Click File menu » Save.

B In the left pane of the Save As dialog, click Training Files, and then, in the file window,
double-click Imperial [Metric].

B For File name, enter Getting_Started, and click Save.

3 Zoom to a view:
B In the Project Browser, double-click Elevations (Building Elevation) » South.

B Enter ZR, to zoom to a specific region.
Note that the cursor changes to a magnifying glass.

B In the drawing area, move the cursor diagonally and click to draw a rectangle around the

level markers.
The area within the rectangle is magnified to fill the drawing area so that you can work with

the level marker text.



4 Rename levels:
B Double-click the Level 1 text, enter 00 Foundation, and press ENTER.
Use a number as a prefix to the name so the plans are sorted by level.

B In the alert dialog, click Yes to rename corresponding views.
The tloor and ceiling plans for Level 1 are renamed 00 Foundation.
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B Using the same method, rename Level 2 and its corresponding views as 01 Lower Level.

5 Create levels in the building:
B Enter 20 to zoom out.

B On the Design Bar, click Level.

B On the Options Bar, click m (Pick Lines), and, for Offset, enter 10" [3000mm)].

B Inthe drawing area, highlight the 01 Lower Level line; when a dashed line is displayed above
the level line, click to create a level (Level 3).

B Using the same method, create a level above Level 3.

6 On the Design Bar, click Modify to end the command.
7 Rename the new levels and all corresponding views:

B Level 3: Rename as 02 Entry Level

B Level 4: Rename as 03 Roof

8 Double-click the level dimensions, and enter new values:
B 00" [0mm]: Change to -14'0" [-53250mm]

B 100" [4000mm]: Change to -10'0" [-3050mm)]

B 200" [7000 mm]: Change to 0'0" [0 mm]
B 300" [10000 mm]: Change to 10'0" [3050 mm)|

9 On the Design Bar, click Modify.
10 Save the project file.



Creating Walls

In this exercise, you work on different levels to add foundation walls to the project.

1 In the Project Browser, under Floor Plans, double-click 00 Foundation to open that view in the
drawing area.

2 On the Design Bar, click Wall.

3 In the Type Selector, select Basic Wall : Retaining - 12" Concrete [Basic Wall : Retaining - 300mm
Concrete].

4 On the Options Bar:

m Click ﬁ (Draw).

B For Height, select 02 Entry Level.

B For Loc Line, verify that Wall Centerline is selected.
B Verify that Chain is selected.

5 In the drawing area, draw walls on the foundation level:
B Click in the lower right quadrant to select the wall start point.

B Move the cursor to the left, enter 40' [12000 mm], and press ENTER.

NOTE You do not need to specify the unit; Revit Architecture uses the units specified in the project
template.

B Beginning at the new endpoint, move the cursor up, enter 22' [6900 mm], and press ENTER.
B Move the cursor to the right, enter 40 [12000 mm)|, and press ENTER.

6 On the Design Bar, click Modify to exit the command.
7 In the Project Browser, under Floor Plans, double-click 01 Lower Level.
8 On the Design Bar, click Wall.

9 In the Type Selector, select Basic Wall : Foundation - 12" Concrete [Basic Wall : Foundation -
300mm Concrete].

10 On the Options Bar, for Depth, select 00 Foundation.



11 Draw walls on the lower level:

B In the drawing area, click the right endpoint of the south wall as the wall start point.
Mowe the cursor to the right, enter 6' 6" [1950 mm)], and press ENTER.
Move the cursor up, enter 3' [1500 mm)], and press ENTER.

Move the cursor to the right, enter 10" 6" [31530 mm)], and press ENTER.

Move the cursor up, and select the intersection with the extension of the north wall.

------------------- 3 : 4

B Select the right endpoint of the north wall to complete the chain and connect the walls.

12 On the Design Bar, click Modify.
13 Save the project file.

Creating Terrain

In this exercise, you create a 3D view and add a toposurface to the building site.

1 In the Project Browser, under Floor Plans, double-click 02 Entry Level.

2 Create a 3D view:
B Click the View tab of the Design Bar, and click Camera.

B Click in the upper right corner of the drawing area to place the camera.

B Click to place the camera target point, as shown.






A 3D view is created. The view you create may differ slightly from the illustrations shown
in the exercises because of minor variations in camera placement. Drag the blue circular
controls that display on the crop region of the resulting view so that you can see the building.

3 In the Project Browser, expand 3D Views, right-click 3D View 1, and click Rename.
4 In the Rename View dialog, enter To Building, and click OK.

5 Create a graded building site:

In the Project Browser, under Floor Plans, double-click Site.
Click the Site tab of the Design Bar, and click Toposurface.
On the Options Bar, for Elevation, enter -0 6" [-150 mm].

Add points to the left of the building, as shown.
The order of the point selection is not important.

[. '\_l

B On the Options Bar, for Elevation, enter -10' [-4000 mm)].



B Add points near the center of the building, as shown.
Contour lines are displayed.

B On the Options Bar, for Elevation, enter -11" [-4300 mm)].

B Add points to the right of the building, as shown.

B On the Design Bar, click Finish Surface.

6 Create a pad surface:
B On the Design Bar, click Pad, and then click Lines.
B On the Options Bar, click E (Rectangle).

B Select the outer endpoint at the lower left of the building, as shown.



B Select the outer endpoint at the upper right of the bullding.
B O the Design Bar, click Finish Sketch.

¥ Open the To Bullding 3D view to see the results.

B Save the project file.
In this exercise, you created a simple toposurface in Revit Architecture by selecting points.
However, for most projects, complex site models created by civil engineering professionals will

be provided to you In DWG, DXFE DGN, or point files. You can import these files inko your
Revit Architecture project where you can automatically generate a terrain using the Toposurface

tool.

Adding Exterior Walls

In this exercise, you bulld wpon the foundation walls. You use the Draw option to create exterior walls that
extend to the roof level.

1 Add walls to the entry level:
In the Project Browser, under Floor Plans, double-click 02 Entry Level.

Click the Basics tab of the Deslgn Bar, and click Wall.
In the Type Selector, select Basic Wall : Generic - &7 [Basic Wall : Generic - 200mmi.

On the Options Bar, for Height, select 03 Roof, and for Loc Line, select Core Face: Interior.
The Height setting defines how tall the wall is and establishes a relationship between the
walls and the roof. After you draw the walls, If you change the roof helght, the helght of the
walls will also change.



B Beginning at the bottom right, trace the interior of the 3 existing retaining walls by selecting
endpoints.

B On the Design Bar, click Modify.

2 Add walls to the lower level:

B Open the 01 Lower Level floor plan.
Motice that the foundation walls are now visible at the right of the plan, so that you can
trace them.

On the Design Bar, click Wall.
Cn the Cptions Bar, for Height, select 03 Roof.,

Beginning at the left endpoint of the north foundation wall, trace the interior of the
foundation walls by selecting endpoints.

B On the Design Bar, click Modify.

3 Open the To Building 31 view.
4 Save the project file.

Adding a Roof

In this exercise, vou Create a roof using the footprint of the exterior walls. You specify an offset as vou create
the roof 50 that the roof has an overhang,

1 Open the 03 Roof floor plan.
2 Draw a roof ling:
B On the Design Bar, click Roof » Koof by Footprint, and then click Lines.

B On the Options Bar, verify that Defines slope is selected.

B Todraw the first roof segment, begin at the bottom left and trace the exterior edge of the
south wall by selecting the left wall endpoint and the intersection of the south and far east
wall.



3 Create offset roof lines:

B On the Options Bar, click E (Pick Lines), for Offset, enter 3' |9 mm), and clear Defines
slope.

W Inthe drawing area, highlight the west wall; when a dashed line is displayed on the exterior
of the wall, click to place the roof line. Repeat for the north and east walls.

4 Use the Trim/Extend tool to close the roof sketch:

B On the Tools toolbar, click ﬂ {Trim/Extend).

W Select the east roof ling, and then select the south roof line. Repeat for the west and south
roof lines.

=

B On the Design Bar, click Finish Roof.
The resulting roof has an odd slope, which you coreect in the next step.

5 Modify the roof slope:

B Select the roof, and cchIp; (Propertiesh.

B In the Element Properties dialog, under Dimensions, for Slope, enter 1"/12" [37], and click
Ok,

B On the Design Bar, click Modify.



& Open the To Building 3D view.

Select and modify the crop region as necessary to see the roof. The walls are not attached to the
roof; vou will attach them in a later exercise.

7 Save the project file.

Adding Floors

In this exercise, you create floors in the building model.

To create floors in Revit Architecture, you must sketch them first in a sketch editor. You use 2 different
sketching options, Pick and Draw, to sketch the floors.

1 Open the 01 Lower Level floor plan.
2 Create a floor using the Pick method:
B On the Design Bar, click Floor, and then click Lines.

B On the Options Bar, click M (Pick Lines), and verify that Offset is (.
B Beginning with the north wall and moving counterclockwise, select the interior of the walls.
B On the Design Bar, click Modify.

3 Enter ZR, and zoom in to the top right corner of the model.

If the floor lines do not create a closed sketch, the sketch is invalid and you need to clean the
lines up. To be valid, the sketch must be a closed loop with no disconnected or crossing lines.

4 Create a closed sketch:

B On the Tools toolbar, clu:kﬂ (Trim/Extend).

B Trim as necessary, selecting the portion of each line you want to retain.

B Enter ZF to zoom to the previous display.
B On the Design Bar, click Finish Sketch.

5 In the alert dialog, click No.



If vou clicked Yes, the walls that finish on the lower level would be trimmed to the underside
of the floor.

& Create a floor using the Draw method:

Open the 02 Entry Level floor plan.
Cn the Design Bar, click Floor, and then click Lines.

Cn the Options Bar, click ﬂ {Draw), and verify that Chain is selected.

Beginning at the lower left interor corner, select the lower endpoint of the west wall, and
then select the upper endpoint.

Mowve the cursor to the right 36" [10000 mm)], and click to draw the sketch line.

Mowve the cursor down 16'6" [5300 mm] to align with the outside of the wall, and click to
specify the point.

Mowve the cursor to the right 25" [9000 mm], and click.

Mowve the cursor down 46" [1300 mm] to align with the inside of the wall, and click.

Move the cursor to the left, enter 5Z to find the loop endpoint, and select the endpoint to
complete the floor sketch.

O the Design Bar, click Finish Sketch.

7 In the alert dialog, click No.
& View the floors in 30:

Open the To Building 310 view.

Select the wall as shown.




O the View Control Bar, click Temporary Hide/Isolate » Hide Element.
The selected wall is temporarily hidden so that you can see the interior floors.

On the View Control Bar, click Model Graphics Style » Shading with Edges.
O the View Control Bar, click Temporary Hide/Isolate » Reset Temporary Hide/Isolate.

9 Save the project file.

Adding Interior Walls

In this exercise, you add walls on the lower level and the entry level, and then modify the walls to create
rooms in the building.

L

1 Cpen the 01 Lower Level floor plan.

2 On the Design Bar, click Wall.

3 In the Type Selector, select Basic Wall : Generic - 6" [Basic Wall : Generic - 200mm].
4 On the Options Bar:

Click ﬁ (Draw).

For Height, select 02 Entry Level.
For Loc Line, select Wall Centerline,
Clear Chain.

5 Add walls:

Zoom in to the west wall, move the cursor along the north wall centerline, enter 26" [B000
mm], and press ENTER to specify the wall start point. Move the cursor down, and click on
the south wall centerline to complete wall 1.

O the Design Bar, click Modify.
Right-click on the wall, and click Create Similar.
Using the following illustration as a guide, place additional walls to create rooms.

[
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6 Modify walls to create a corridor:

i
®  On the Tools toolbar, c]u:kﬂ (Split), and click on wall 1 in the area indicated by the short
line in the previous illustration.

B On the Tools toolbar, click ﬂ {Trim/Extend).

®  Trim the split wall to create a corridor, as shown.

7 On the Design Bar, click Modify.
8 Draw walls:
B Open the 02 Entry Level Aoor plan.

® Right-click on one of the half-tone walls shown in the underday of the lower level, and click
Create Similar.

B Using the following illustration as a guide, place additional walls to create rooms.

LI

2 On the Design Bar, click Modify.
The walls defining the rooms on the lower level and the entry level are complete.

10 Save the project file.

Adding Doors

In this exercise, vou load doors from the Training Files folder into the project, and then add interior and
exterior doors to the model.

1 On the Basics tab of the Design Bar, click Door.

There are a limited number of door types in the project because there were few in the default
template. You can load additional door types from the Training Files folder.

2 Load doors from the Training Files folder:
B On the Options Bar, click Load.

B In the left pane of the Load Family dialog, click Training Files, and open
“mperial’ Families' Doors [Metrich Families\ Doors].

B While pressing CTRL, select the door types: Bifold-4 Panelrfa, Double-Glass 2.rfa, Single-Glass
2.rfa [M_Bifold-4 Panel.rfa, M_Double-Glass 2.rfa, M_Single-Glass 2.rfa].

B Click Open.

3 Add exterior doors:
B Open the 01 Lower Level floor plan.

B On the Design Bar, click Door.
B On the Options Bar, clear Tag on Placement.
n

In the Type Selector, select Double-Glass 2 : 727 x 84" [M_Double-Glass 2 : 1830 x 2134mm],
add a door to the east wall as shown, and then click Modify.



Crpen the 02 Entry Level floor plan.
On the Design Bar, click Door.
In the Type Selector, select Double-Glass 2 : 727 x 84" [M_Double-Glass 2 : 1830 x 2134mm].

Place the door in the north wall 7' [2100mm] from the end of the retaining wall, as shown.
- LY

W In the Type Selector, select Single-Glass 2 : 36" x 84" [M_Single-Glass 2 : 0915 x 2134mm].

B Place the door in the short vertical wall, as shown.

NOTE To change the swing direction as you place a door, press SPACERAR. To change the swing
after a door Is placed, dlick the fllp amows.

o g

4 Add interior doors:

B In the Type Selector, select Single-Flush - 327 x 84" [M_Single-Flush : 0813 x 2134mm], and
add 2 doors, as shown.

B Open the 01 Lower Level floor plan.
B On the Design Bar, click Door.

B In the Type Selector, select Single-Flush : 307 x 84" [M_Single-Flush : 0762 x 2134mm)], and
place 2 doors, as shown.

-
L
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B In the Type Selector, select Bifold-4 Panel : 727 x 84" [M_Bifold-4 Panel : 1830 x 2134mm],
and place 2 doors, as shown.

L

¥

5 Open the To Building 3D view.

& For an unobstructed view of the doors, select a wall, and on the View Control Bar, click Temporary
Hideflsolate » Hide Category.
All the walls in the view are hidden.




Attaching Walls to the Roof

In this exercise, vou attach interior and exterior walls to the roof. When you attach the curtain walls, Revit
Architecture wams you of consequences and modifies the placement of mullions.

1 Open the 03 Roof floor plan.
2 Attach the basic walls:
B While pressing CTRL, select all the interior walls and exterior walls, except the curtain walls.

B On the Options Bar, click Attach.

B For Attach ‘Wall, verify Top is selected.
B In the drawing area, select the roof.
m Click in the drawing area, or click Modify on the Design Bar to end the command.

3 Attach the curtain walls:
m Open the North elevation view.

B Move the cursor over the curtain wall, and press TAS until the status bar indicates that the
curtain wall is selected, select the outside edge of the curtain wall, and then click Attach.

B Select the roof.
B In the error dialog about curtain wall mullions, click Delete Elements.
B Open the East elevation view, and attach the east curtain wall to the roof.

4 Open the To Building 3D view.
5 On the View Control Bar, click Shadows Off » Shadows On.

All walls extend up to the roof. Note the spacing of the top row of mullions/panels; because the
spacing parameter cannot be satisfied, mullions are created where the walls and roof attach.

& Save the project file.



Adding Stairs and Railings

In this exercise, vou complete the interior of the model by adding a staircase on the lower level, and then
adding and modifying railings on the lower level and the entry level.

1 Open the 01 Lower Level floor plan.
2 Add stairs:
B Zoom in to the east side of the model.

Click the Modelling tab of the Design Bar, and click Stairs.

]
B Click near the double doors to start the stair run.
]

Move the cursor to the left until the tooltip indicates that no risers remain, and click to
specify the stair endpoint.

4L

®  On the Design Bar, click Finish Sketch.

3 Edit the floor profile:
B Open the 02 Entry Level floor plan.

B Zoom in to the east side of the model.

B Select the floor, and on the Options Bar, click Edit.



On the Design Bar, click Lines.

Cn the Options Bar, verify that Chain is selected.

Click at the comer of the model lines below the stairs to specify the start point.
Move the cursor to the left, enter &' [1800mm], and press ENTER.

Move the cursor up, enter 3'4" [1100mm], and press ENTER.
This distance is the width of the stair and its stringers.

Mowe the cursor to the right, and click on the vertical line to complete the sketch.

On the Design Bar, click Modify.

Select the vertical model line closest to the stairs, and drag the bottom endpoint up to the
endpoint of the short horizontal line drawn previously.

]

O the Design Bar, click Finish Sketch.
In the alert dialog, click No.

4 Move the stairs and railings:

Using a selection window, select the stairs and railings. To select only elements completely
within the boundary of the window, drag the cursor from left to right.

B On the Tools toolbar, clu:kw Move).

B Click the lower left comer of the stairs as the move start point.

B Click the lower corner of the modified floor profile as the move end point, and then press

ESC.



DM
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5 Modify the railing type:

Cpen the To Building 31 view.
While pressing CTRL, select both railings (zo0m in as necessary).
In the Type Selector, select Railing : Guardrail - Pipe [Railing : 9%00mm Pipe].

& Add a railing to the entry deck:

Open the 02 Entry Level floor plan.

Cn the Modelling tab of the Design Bar, click Railing, and then click Railing Properties.
In the Element Properties dialog, for Type, select Guardrail - Pipe [%00mm Pipe], and click
Ok,

On the Options Bar, click E (Pick Lines), and for Offset enter 4" [150mm].

Zoom to the entry deck on the north side of the model.

Click the interior of the angled floor on the right, and then click the interior of the adjacent
vertical floor line, as shown.

A A
On the Design Bar, click Modify, and then select the angled railing.

Drag the left endpoint to the right, so that the resulting railing extends just past the retaining
wall.

Select the vertical railing, and drag the lower endpoint up until the resulting railing is 100
[3000mum.

O the Design Bar, click Finish Sketch.



¥ Add a railing on the north side of the stairs:
B Onthe Design Bar, click Railing.

B Onthe Options Bar, click M {Pick Lines), and for Offset enter 4" [150mimn)].

B Click to the left of the vertical floor line above the stairs, and then click above the left north
edge of the stairs.

B Onthe Design Bar, click Modify.

B On the Tools toolbar, c]'u:kil (Trim/Extend).
W Select the left side of the horizontal railing, and then select the vertical railing.
B On the Design Bar, click Finish Sketch.

1 i T |
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8 Add a railing to the balcony:
B Zoom to the lower right corner of the model.

m  Onthe Design Bar, click Railing.

B Onthe Options Bar, click E (Pick Lines), and for Offset enter 4" [150mm].

B Click above the south floor line, and, continuing in a counterclockwise direction, click the
interior of the remaining 2 floor lines that define the balcony.



L
.

1

W On the Design Bar, click Modify.

W Select the last line drawn, and drag the left endpoint to the right, just to the east of the
exterior wall.

—

W Select the south railing line, and drag the left endpoint to the right until it touches the
exterior wall near the door.

W On the Design Bar, click Finish Sketch.




Documenting the Project

In this exercise, vou add tags to the project and schedule doors and rooms. You change an element in the
door schedule and see that the change is automatically made in the associated plan. You also add color fill
to rooms and modify crop regions for several views that vou later add to a presentation sheet view.

1 Create a section view:
® Open the 02 Entry Level floor plan.

®m Click the View tab of the Design Bar, and click Section.

B Begin the section on the left side of the model and end it on the right side, making sure it
cuts through the stairs.

R

B Onthe Design Bar, click Modify.

B Doubleclick the middle of the section head circle to display the section view.
Alternatively, in the Project Browser under Views, expand Sections (Building Sections), and
double-click Section 1.
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2 Add door and window tags:
B COpen the 02 Entry Level floor plan.

B Click the Drafting tab of the Design Bar, and click Tag All Not Tagged.
B In the Tag All Not Tagged dialog, press CTRL, and under Category, select Window Tags.
]

Click OK
¥
®l
el
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B Open the 01 Lower Level floor plan, and use the same procedure to tag all doors and windows
in the view.

3 Create a door schedule:
® Click the View tab of the Design Bar, and click Schedule/Cuantities.

B In the New Schedule dialog, for Category, select Doors, and click OF.
B [n the Schedule Properties dialog, for Available fields, select Family and Type, and click Add.



B Add the following fields: Width, Height, and Mark.

B Using the Move Up button, move Mark to the top of the list so that it displays first in the
schedule.

B Click the Sorting/Grouping tab, for Sort by, select Mark, and click OF.
B Doubleclick on the right column boundary of the Family and Type column to expand it to

its full width.
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4 Change a door schedule:

B For the Mark 7 door, click the Family and Type field, and select Bifold-4 Panel : 60" x 84"
[M_Bifold-4 Panel : 1525 x 2134mm)].

m Open the 01 Lower Level floor plan.
Motice that the bedroom door tagged 7 is now a bifold door. Changes made in the schedule
are automatically synchronized in the associated plan.

B In the Type Selector, select Single-Flush - 30" x 84" [M_Single-Flush : 0762 x 2134mm] to
return the door to the original family and type.

B In the Project Browser, under Schedules/Cruantities, double-click Door Schedule.
The Mark 7 door is also restored to the original type in the schedule. This bidirectional
associativity in Revit Architecture ensures that changes made to any part of the design are
coordinated in all associated views, including schedules.

5 Modify the properties of the 3 retaining walls to specify them as bounding elements for room
ared calculation:

m Open the 01 Lower Level floor plan.
B On the Design Bar, click Modify.

B While pressing CTRL, select the 3 retaining walls, and cllck (Properties).
B In the Element Properties dialog, under Constraints, select Room Bounding, and click OK

& Create a Room schedule that contains the following fields:
B Number

B Name
B Ared

The schedule is empty but is updated when you add rooms and room tags to the building.

7 Add rooms and room tags on the entry level:
B Open the 02 Entry Level floor plan.

B Click the Room and Area tab of the Design Bar, and click Room.



B Click to the left of the stairs to tag the large room, click in the upper room on the west side

of the building, and then click in the small room on the west side.

B On the Design Bar, click Modify.

B Doubleclick the tag text in the large room, change it to Entry, and press ENTER.

B Change the tag text in room 2 to Bedroom, and the text in room 3 to Store.
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8 Add rooms and room tags on the lower level:
B Open the 01 Lower Level floor plan.

B On the Room and Area tab of the Design Bar, click Room.

B Beginning in the large room on the right and moving clockwise, click in each room o add

the tags.

B On the Design Bar, click Modify.

B Doubleclick the tag text in the large room, change it to Living Room, and then press ENTER.

B Change the tag text in room 5 to Bedroom, the text in room 6 to Bathroom, and the text in

mooms 7 and 8 to Store.
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9 Open the Room Schedule view to see that it includes data for the specified fields.
10 Define the floor in the Entry:

Open the 02 Entry Level floor plan.
On the Room and Area tab of the Design Bar, click Room Separation.

Trace the floor line from the north wall down to and around the stairs to define the Entry
room and create a separate floor profile for that room.



e .

The area for the entry room is updated in the room schedule.

11 On the Design Bar, click Modify.
12 Modify tags:

Open the 01 Lower Level floor plan.

Double-click the tag for one of the windows in the south wall, enter A, and press ENTER.
In the alert dialog about changing a type parameter, click Yes.

Orpen the 02 Entry Level floor plan.

Double-click the tag for one of the windows in the west wall, enter B, and press ENTER.
In the alert dialog, click Yes.

13 Add color fill to the rooms:

Cn the Room and Area tab of the Design Bar, click Color 5cheme Legend.
In the drawing area, click to the right of the building to place the color fill legend.

In the Choose Space Type and Color Scheme dialog, for Color Scheme, select Name, and
click OF.

Cn the Design Bar, click Modify.

Select the left vertical wall, and move it slightly to the left.
All of the walls resize to accommaodate the new wall dimension. The color fill in the bedroom
and storage room readjusts and the room areas are automatically updated.

Crpen the Room Schedule view to see that the bedroom and storage room areas have changed.

[ ]
Cn the Standard toolbar, click J (Undop to restore the wall to its original dimension.



B Reopen the 02 Entry Level floor plan and verify the wall has changed.
14 Open the 01 Lower Level floor plan and repeat the prévious procedure in that view.
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15 Modify a crop region 0 create a view for a sheet:
B Open the 01 Lower Level floor plan.

B On the View Control Bar, click Show Crop Eegion.
B Enter ZF to zoom to fit the entire view in the drawing window.
m Select the crop region, and drag the triangular blue controls to shrink the region around the
model.
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B On the View Control Bar, click Hide Crop Region.

16 Using the same method, modify the following views:
B 02 Entry Level floor plan

W East elevation view
B North elevation view



